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Chapter 1

Introduction

This chapter introduces to the application Sysquake, the interactive
design CAD tool for getting insight into complicated scientific problems
and designing advanced technical devices. You should read it to know
more about what Sysquake is, what it may be used for, and how to
use it for simple tasks.

1.1 Introduction

To design technical devices, or to understand the physical and math-
ematical laws which describe their behavior, engineers and scientists
frequently use computers to calculate and represent graphically dif-
ferent quantities, such as the sample sequence and the frequency
response of a digital audio filter, or the trajectory and the mass of
a rocket flying to Mars. Usually, these quantities are related to each
other; they are different views of the same reality. Understanding
these relationships is the key to a good design. In some cases, espe-
cially for simple systems, an intuitive understanding can be acquired.
For more complicated systems, it is often difficult or impossible to
"guess", for instance, whether increasing the thickness of a robot arm
will increase or decrease the frequency of the oscillations.

Traditionally, the design of a complicated system is performed in
several iterations. Specifications can seldom be used directly to cal-
culate the value of the parameters of the system, because there is
no explicit formula to link them. Hence each iteration is made of two
phases. The first one, often called synthesis, consists in calculating
the unknown parameters of the system based on a set of design vari-
ables. The design variables are more or less loosely related to the
specifications. During the second phase, called analysis, the perfor-
mance of the system is evaluated and compared to the specifications.
If it does not match them, the design variables are modified and a new
iteration is carried out.
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When the relationship between the criteria used for evaluating the
performance and the design parameters is not very well known, mod-
ifications of the design parameters might lead as well to poorer per-
formance as to better one. Manual trial and error may work but is
cumbersome. This is where interactive design may help. Instead of
splitting each iteration between synthesis and analysis, both phases
are merged into a single one where the effect of modifying a param-
eter results immediately in the update of graphics. The whole design
procedure becomes really dynamic; the engineer perceives the gra-
dient of the change of performance criteria with respect to what he
manipulates, and the compromises which can be obtained are easily
identified.

Sysquake’s purpose is to support this kind of design in fields such
as automatic control and signal processing. Several graphics are dis-
played simultaneously, and some of them contain elements which can
be manipulated with the mouse. During the manipulation, all the
graphics are updated to reflect the change. What the graphics show
and how their update is performed are not fixed, but depend on pro-
grams written in an easy-to-learn language specialized for numeric
computation. Several programs are included with Sysquake for com-
mon tasks, such as the design of PID controllers; but you are free to
modify them to better suit your needs and to write new ones for other
design methods or new applications.

Another area where Sysquake shines is teaching. Replacing the
static figures you find in books or the animations you see on the Web
with interactive graphics, where the student can manipulate himself
the curves to acquire an intuitive understanding of the theory they rep-
resent, accelerates and improves the learning process tremendously.

1.2 How Sysquake can be used
Sysquake is expected to be used mainly for three different purposes.

Understanding basic concepts In science as well as in engineer-
ing, theory is often not very intuitive at first, because it relates
quantities from different domains: energies and positions, time
and frequency, temperatures and entropies. In automatic control,
where feedback is used to improve performance of any kind of sys-
tem, transient behavior, such as settling time, overshoot, and risk
of actuator saturation, is typically analyzed in the time domain;
while the stability, noise rejection, and different kinds of robust-
ness are more easily expressed in the frequency domain. The basic
mechanisms which relate these quantities can be illustrated very
effectively with Sysquake.
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Designing systems The quality of a device is always the result
of a compromise. Multiple objectives, such as the speed, the ac-
curacy and the cost, must be taken into account simultaneously
and have contradictory requirements. Sysquake helps a lot to find
which compromises are feasible, how to push the design in the de-
sired direction, and how to modify the specifications in case they
do not permit a satisfying solution.

Developing and testing new design methods Some design
methods still in use were developed at the time when computers
were either nonexistent or too expensive, or too slow for interac-
tion. While they can also benefit from Sysquake, they are better
complemented or replaced by approaches which offer more de-
grees of freedom for better performances. A lot of work can un-
doubtedly be done in this field.

There is more or less a one-to-one correspondence between these ap-
plication fields and the ways Sysquake can be used.

Ready-to-use interactive figures A static figure which
illustrates a basic concept in a book or a course on the World Wide
Web can be replaced with a dynamic figure, where the reader
manipulates an element and sees its effect. For instance, to show
how the height of a building influences the amplitude of its
oscillations during an earthquake, the student is invited to
change the building height with the mouse and see how the
earthquake simulation is modified. To support this (and much
more complicated interactive figures), Sysquake loads an SQ file,
a text file which contains the description of the figures and the
code necessary to support the interaction. SQ files do not have to
handle advanced features provided automatically by Sysquake,
like multiple undo, zoom, and scale options. They rely on built-in
functions for graphics related to linear dynamic systems, but can
also compute and display arbitrary data with a complete
language.

Set of programs for different design or analysis methods SQ
files are not limited to a fixed set of figures and interaction. They
can implement all that is needed for a given design or analysis ap-
proach. Then the user chooses what he wants to display, may enter
numeric parameters which characterize the problem, and manipu-
lates the graphics until he obtains the desired results. He can also
save the parameters of his design in an SQD file (Sysquake Data
file) and load them later.

Programs written from scratch The applications described
above are based on SQ files, which either come from those
distributed with Sysquake or are contributed by other users, or are
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Figure 1.1 Sysquake on Windows XP

written from scratch. Developing an SQ file is not difficult;
however, it requires some programming knowledge and
experience. For small problems, a simpler programming model is
available, SQ scripts.

These purposes are the raison-d’étre of Sysquake which make it
different from any other general-purpose math software. However,
Sysquake can also be used as a powerful calculator for quick
interactive evaluation of expressions.

Another advantage of Sysquake is that it runs on both Windows
(see Fig. [1.I) and Mac OS X (see Fig. [I.2), with a polished user in-
terface. Other Calerga products share the programming language of
Sysquake. For example Sysquake Remote provides scientific comput-
ing and graphics for Web applications (more informations can be found
on the Web site of Calerga, https://calerga.com). The part of the appli-
cation which does not rely on Sysquake-specific features (interactive
graphics) can be easily reused in these products.



Introduction

L é Sysquake File Edit Figure Layout Window Help

Function Approxima

[aXaRA]

Manipulation Mode

Approximation

e lalalal

0.5

clc
plot(rand(1,10))
eigl(2,3:5,1])

vl

Figure 1.2 Sysquake on Mac OS X

approx.sq
nodes = chebNodes(n+1, x@-dx, x@+dx): r
switch fn
case @
¥ = exp(x);
yn = exp{nodes);
Appra case 1
y = sin(x); [:]
yn = sin{nedes);
M (5} end
£ = Feumfun)  zarncf1  nYl-
806 Sysquake Command Window (=)
> plot(rand(1,18))
- > eig([2,3;5,11)
Figure ans = e
5.4@51 i
) -2.4051 v
> | p—
A







Chapter 2

Registration

Sysquake Pro and Sysquake Application Builder require a registration
key file in order to run. Please follow the instructions you have re-
ceived with Sysquake.

Licenses for multiple computers and site licenses do not require
separate registration for each computer; the same registration file is
used on each computer. If your company or university has acquired
such a license, a single person should be responsible for the regis-
tration file deployment; Calerga cannot easily accept and validate re-
quests from multiple persons for the same license.

2.1 Where SQ Reg.key is located

The registration information is stored in the file SQ_Reg.key on the
hard disk. Its location depends on the operating system.

Windows

On Windows computers, SQ_Reg.key is located in the same folder as
Sysquake.exe, typically in the directory C:\Program Files\Sysquake.

If the installer application finds the file SQ Reg.key in the same
directory where it is located, it copies it automatically to its final loca-
tion.

macOS

On macOS computers, SQ Reg.key can be located in three different
places:

— in the same folder as the Sysquake application;

- in "/Library/Calerga, where " stands for your home folder;
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- in /Library/Calerga (starting in the boot volume).

If Sysquake Pro or Sysquake Application Builder cannot find a
valid registration file at startup, it will request one and copy it to
“/Library/Calerga. If Sysquake is used by different users on the
same computer, you can move it to /Library/Calerga (you need
administrator privileges to do that).

The folder of Sysquake is usually not recommended to reduce clut-
ter in the Applications folder and to avoid deleting it when you replace
Sysquake with a newer version.

Linux

On Linux computers, SQ_Reg.key is located in the base directory of
Sysquake, typically /usr/local/sysquake.

2.2 Remark

The serial number is linked to your name and your company’s hame.
The protection system is designed to permit you to reinstall the serial
number easily, on the same or a different computer. You may even
copy the registration file onto different computers if you have a multi-
ple license for the same software, or to your private laptop computer.
License files for Windows and Mac OS are compatible. Simply make
sure you comply with the license terms.

When you perform a minor upgrade of Sysquake, you can keep the
same registration file without running the registration application or
contacting Calerga again.

2.3 What’s in the Serial Number

The serial number is not a random string of letters and digits. It can
be decoded as follows. A typical serial number looks like

500549a-999999-0a20.a392

To decode it, split it into six parts:
VVVWwwT - yyyymm-Ssss. ssss

Each group of characters has the following meaning:

- vvv, a group of three digits, is the first version number for which
the license is valid; 500 means 5.0.
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- www, a group of three digits, is the last version number for which
the license is valid; 549 means 5.4.9. Note that this is not a
commitment to offer free upgrades, or any upgrade at all.

- f, a single letter, identifies additional capabilities of Sysquake; a
means none. It is not used in current releases.

- yyyy, a group of four digits, is the last year of the validity of the
license; 9999 means no expiration.

- mm, a group of two digits, is the last month for which the license
is valid; 99 means no expiration.

— §S5S5S.58SSS, a group of eight hexadecimal digits, is an encrypted
checksum which binds the serial number to other bits of registra-
tion information.






Chapter 3

Getting Started with
Sysquake

This chapter describes the user interface of Sysquake, i.e. how you
manipulate its windows and what you can find in its menus.

3.1 First steps

Launch Sysquake, then choose File/Open (i.e. click the File menu, then
the Open item) and select the file sampling.sq, which should be lo-
cated in the "SQ Files" folder, to learn basic manipulations. The pur-
pose of this SQ file is to show the effect of sampling (and other method
for converting systems from continuous time to discrete time) on the
frequency response and step response.

In the figure window, two graphics should be displayed (see
Fig. [3.1). At the top, the frequency response amplitude of a
continuous-time third-order system is represented as a black line.
The red curve represents the frequency response amplitude of the
same system, but sampled. The sampling frequency is represented
by the blue vertical line, and the Nyquist frequency (half of the
sampling frequency) in green. The discrete-time curve has a
periodicity equal to the sampling frequency. The bottom figure
represents the step response of the system, again both in the
continuous-time domain and in the discrete-time domain (red circles).

If you click one of the vertical lines and hold down the mouse but-
ton, you can move the line to the right to increase the sampling fre-
quency or to the left to decrease it. More interesting is the effect on
the discrete-time responses. Both the frequency responses and the
step responses are updated during the move. If you decrease enough
the sampling frequency, the frequency response matches more and
more loosely the continuous-time response. In the time domain, you
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Figure 3.1 SQ file sampling.sq

can see that the samples do not follow the oscillations. You can also
click and move (or drag) one of the samples in the step response plot.

A very useful feature of Sysquake is the Undo command. You can
undo and redo any interactive manipulation, change of settings, zoom,
and choice of figures to display, as many times as memory permits.
These commands can be found in the Edit menu. They are your
friends; learn to use them frequently!

3.2 Files

Sysquake uses several kinds of files: SQ files, SQD (or SQ Data) files, li-
braries, and files created by programs. SQ files are kinds of programs,
or scripts, which implement figures, menus and computation code for
a given topic. Several SQ files are provided with Sysquake. Some of
them are suitable for many problems in the same area and can be
customized with your own data, for example for the design of a digital
filter, while others have more narrow applications.

You can also write your own SQ files with an external text editor.
If you use a word processor, make sure that you save SQ files as text
only, or ASCII; many word processors add formatting information (such
as margins or character style) which is not understood by Sysquake.
On Macintosh, SQ files are associated with Sysquake and get an SQ
file icon when you open them with Sysquake for the first time, either
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from Sysquake (menu File/Open) or by dragging the document icon
onto Sysquake’s; then you can simply double-click the SQ file icon in
the Finder to open it in Sysquake.

SQD files store the state of a session with Sysquake. They are al-
ways associated with an SQ file. They only contain the data necessary
to load back the SQ file and restore the parameters, settings and fig-
ures which were defined when they were saved. Typically, they are
written and read by Sysquake; but since they are also text files, you
can easily create them by hand, read the values, or use them to ex-
change data with other applications.

Libraries are collections of functions which complement the built-in
functions of Sysquake’s language. They are made available explicitly
to SQ files or other libraries which request them.

With its rich built-in language, Sysquake can also read and write
arbitrary text and binary files. What they contain and when they are
created and read depend only on the programmer. For example, an
image processing SQ file could read TIFF files (a popular file format for
raster images) by adding a custom entry in the Settings menu. This
is actually what image.sq, one of the SQ files provided with Sysquake,
does.

3.3 Manipulation modes

There are five manipulation modes, which can be chosen in the Figure
menu or in the toolbar (toolbars differ slightly on Mac OS (see Fig.[3.2),
Windows (see Fig.[3.3)) and Linux).

Manipulate You can drag graphical elements in one of the sub-
plots and see the effect this has on other figures. Depending on
the figure, you can drag graphical elements horizontally, vertically,
or in any direction. Not all the elements can be dragged; the shape
of the cursor usually indicates whether dragging is enabled (hand
with index finger) or disabled (standard arrow cursor). For some
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figures, holding down the Shift key modifies the action performed
by the drag.

In automatic control and filtering, the dynamic of linear systems
is often represented by poles and zeros symmetric with respect to
the horizontal axis (real axis). To enforce this symmetry, dragging
a complex pole or zero (a pole or zero not on the real axis) also
moves the symmetric one; attempting to drag a complex pole or
zero to the other side of the real axis makes it stick to the real axis;
and dragging a pole or zero from the real axis can be done only
upward if there is at least one other pole or zero on the real axis,
which becomes its symmetric.

Zoom You can click in a subplot to double the scale in both x
and y directions, or select the area you want to display by hold-
ing down the mouse button. To zoom out, hold down the Shift key
and click. To revert to the default scale, select the subplot (see
below) and select Figure/Automatic Scale. Many figures have auto-
matic scaling by default; to fix the scale without zooming, unselect
Figure/Automatic Scale.

In 3D figures, a click zooms in, or zooms out if the Shift key is held
down.

Zoom X Axis The zoom is constrained to the x axis. The scale
remains automatic for the y axis if it already was before the zoom.
Note that figures where the scale for both axis is constrained to be
the same cannot be zoomed in or out in this mode.

In 3D figures, a click zooms in or out with orthographic projection.
With perspective projection, a mouse drag toward the center of the
figure moves the point of view closer to the target point, keeping
the zoom factor such that the image size is preserved. A mouse
drag from the center of the figure has the opposite effect, moving
the point of view further from the target point.

Drag You canclick and drag a figure to move itin its subplot region.
The limits of the displayed area of the plot are changed such that
the point under the mouse cursor moves with it. Hold down the
Shift key to drag along the x axis.

In 3D figures, a mouse drag moves the point of view around the
target point, as if the mouse cursor dragged a sphere around the
object. If the Shift key is held down, both the point of view and
the target point are moved (i.e. the camera dollies parallel to the
image).

Select You can select a subplot by clicking it (this is necessary only
if several subplots are displayed simultaneously), and change what
is displayed by choosing an entry of the Plot menu or some options
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in the Figure menu. By holding down the Shift key, you can select
more than one subplot. You can also drag a figure from one subplot
slot to another one. The figure which was in the target subplot
replaces the dragged figure. The zoom factor and scale options
are preserved. Some commands are available from a contextual
menu (click in the figure with the right button, or hold down the
Control key and click in a figure on Macintosh with a single-button
mouse); you do not need to select a subplot before using it.

It is sometimes useful to synchronize the area displayed in two sub-
plots. For instance, if you display simultaneously the amplitude and
the phase of a frequency response, you may want to zoom along the X
axis to display a smaller frequency range, identical for both figures. To
do that, first select both subplots (switch to Select mode, click the first
subplot, hold down the Shift key, and click the second subplot). Then
switch to Zoom, Zoom X, or Shift mode, and change the scale of one
of the selected subplot. All the selected subplots will follow, provided
that their scale was already the same before the change.

Remark: with some versions of Sysquake, the middle button of
mouses with three buttons has the same effect as holding down the
Shift key and clicking with the left button.

3.4 Menus

This section describes the commands you can find in the menus. The
most important ones have keyboard shortcuts which are more efficient
for the experienced user.

Note that some menu entries are enabled or disabled by the con-
tents of the SQ file currently loaded. For example, in many figures,
such as those with negative values, the logarithmic scale is disabled.

File

The File menu (see Fig.[3.4) contains the commands which handle SQ
files as a whole (file operations and reset to the default values) and
quit Sysquake itself.

New Opens a new text editor window, where you can type the
source code of an SQ file or the contents of any text file. This
is used mainly to develop new Sysquake applications, but can be
convenient as a general-purpose text editor.

Open and Run Opens either an SQ file or an SQD file, i.e. a file
which contains customized values and settings as well as a refer-
ence to the related SQ file. When you open an SQD file, Sysquake
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|[File] Edit Figure Layout View Window
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Figure 3.4 File menu

loads its related SQ file first, then restores the state of the data and
the figures which prevailed when the SQD file was saved.

Open and Edit Opens a text file in the editor window without at-
tempting to running it as an SQ file. You can then inspect it, edit it,
save it, and (if it is an SQ file) run it.

Command Window Displays the command window. The com-
mand window is a window where you can type commands and
evaluate expressions, as well as see the textual output (if any) of
the execution of SQ files. This is especially useful when you de-
velop your own SQ files. On Macintosh, Command Window is in the
Window menu.

Figure Window Displays the figure window. The figure window
is the window where graphics created by SQ scripts or from the
Command window are displayed. On Macintosh, Figure Window is
in the Window menu.

Close Closes the active window. The Figure window and the Com-
mand window are only hidden and can be shown again with the
menu entries described above.
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Save Saves the current values and settings with a reference to the
SQ file in the current SQD file. For an SQD file to be considered as
"current", it must have been opened, or already saved with Save
As. Otherwise, you must select Save As to provide a file name for
the new SQD file.

Save As Same as Save, but a file name and location is requested.

Save As SQ File Same as Save As, except that an SQ file is written
instead of an SQD file. The SQ file has the advantage of being self-
contained and independent from the original SQ file, and the dis-
advantage of requiring more disk storage and not benefiting from
improvements made to the original SQ file. If the SQ file contains
a help text, the mention Saved as SO file (default values are new)
is appended to make clear that the SQ file has been modified. You
can edit the SQ file to change the help message (as well as other
elements) if the SQ file author permits you to do so. On Windows,
Save As SQ File is an option of the Save As dialog.

Export Graphics As The contents of the figure window are saved
as an EPS (encapsulated PostScript) or PDF (Portable Document
Format) file, i.e. a high-quality graphics file which can be imported
in many programs.

Reload Reloads the current SQ file. This is especially useful when
developing your own SQ files with an external text editor.

Reset Data Reverts to the default values of the SQ file or the
values of the SQD file.

Dump Data Writes what would be saved in an SQD file by the Save
command to the Command window or panel. Usually, the result
corresponds to the variables used by the SQ file and contains the
numeric values the figures are based on.

Edit SQ File When the figure window of an SQ file is frontmost,
Edit SQ File switches to its source code in a text editor window. You
can inspect the code, modify it and reload it.

Print Prints the contents of the figure window. Depending on the
operating system, it may also be possible to print the command
window or panel, to specify printing options, and to preview what
would be printed.

Recent files The most recent files can be opened without having
to find them with the Open menu entry.

Quit or Exit Quits Sysquake. On macOS, the Quit entry is located
in the Sysquake menu.
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Edit

The Edit menu contains the commands which manipulate the clip-
board for data exchange within Sysquake and with other programs,
and the Undo/Redo commands. Note that the command-line interface
(the text window where you can type direct commands) may support
only Undo or no Undo at all, depending on the platform.

Undo Reverts to the situation which prevailed before the last user
action. Most figure interactive manipulation and setting in the Set-
tings menu can be undone. Undo can be used as many times as
memory permits.

Redo Undoes the last undo.

Cut, Copy, Paste, and Clear Standard editing operations. In the
figure window, only Copy is supported; it makes a copy of the se-
lected subplot, or of all the subplots, as graphics (the exact format
depends on the operating system).

Select All Selects all the subplots.

Copy As For SQ files which can export data by copying it to the
clipboard, the submenu items show what can be exported. Once
copied, data can be pasted in another SQ file or another applica-
tion. For example, an SQ file for identifying the parameters of a
model based on experiments performed on a real process may be
copied to the clipboard and pasted into another SQ file for the de-
sign of a feedback controller.

Paste As For SQ files which can import data by pasting it from the
clipboard, the submenu items show what can be imported. Data
which can be imported have typically been copied in another SQ
file, but can also come from another application.

Preferences

Depending on the platform, preferences are grouped in a single dialog
window or available separately from a submenu. On macOS, prefer-
ences are found in the Sysquake menu. Settings are saved and re-
stored the next time Sysquake is launched.

Set SQ file path When an SQD file is opened, Sysquake looks for
the name of the SQ file associated with it. Then it looks first in the
folder of the SQD file, then in prespecified folders to load the SQ file
and set the variables based on the contents of the SQD file. With
Set SQ File Path, you can check and change where Sysquake looks
for SQ files. By default, this is in the folder "SQ files", itself located
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Figure 3.5 Preferences submenu

at the same place as Sysquake; but you can change it, or add your
personal folders. Paths also specify where libraries and help files
are searched. Each path is relative to Sysquake, and folders are
separated with new lines.

A path can be:

— The directory which contains the files; the path of the file is
obtained by concatenating this directory and the file name,
with a separator such as / or \ if it is missing.

- A string with character sequences %b, %s and/or %T which are
replaced respectively by the file base name without suffix, the
suffix (extension such as sq for SQ files or lml for libraries),
and the file name with suffix.

The syntax of paths depends on the operating system. On Win-
dows, relative paths begin with a backslash ('\’), and absolute
paths begin with the volume letter followed by a colon (e.g. 'C:’);
each element is separated with a backslash. On macQOS, folders
are selected in a dialog window.

On most platforms, Sysquake also supports URL. SQ files and func-
tions defined in libraries obtained with a URL path are executed in
a sandbox. See function path for more details.

Startup commands Startup commands are LME commands exe-
cuted every time Sysquake is launched. Some global settings can
be changed by calling functions: for instance, format sets the way
results are displayed, and defaultstyle sets the default style of
new figures.

Another use is to import libraries at startup. If you often call
functions from the same libraries (such as stdlib for basic
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function which extend the built-in functions of Sysquake or stat
for advanced functions related to statistics), you can add use
statements as startup commands to make them always available:
use stdlib, stat. Functions are imported only for usage in the
command-line interface, not in SQ files which must specify
explicitly the libraries they use.

Memory The memory usage is adjusted automatically when re-
quired. However, depending on your needs, it may be better to
allocate a large amount of memory at startup or to limit the maxi-
mum amount of memory. We recommend that you keep the default
values, except for the minimum memory which can be increased
but should be kept lower than your physical memory for best per-
formances.

Handle SQ files (Windows only) Windows stores information
about which application should be invoked when a document icon
is double-clicked in a central location called the Registry. If you
move Sysquake, or if you install a new version (e.g. by upgrading
from Sysquake to Sysquake Pro), you should tell Windows if you
want the Sysquake which is currently running to open and print SQ
files. You do so by choosing Handle SQ Files. Then the menu entry
is checked and disabled, because you cannot revert your action.
To select another version of Sysquake, run it and select Handle SQ
Files from it.

Interactive figure hilight When selected, the frame around in-
teractive figures (subplots where there are elements which can be
manipulated with the mouse) is displayed in red instead of black.
In many cases, the mouse cursor also changes when the mouse is
over an element which can be manipulated.

Thick lines When selected, all lines in graphics are displayed with
thicker lines. This may be useful for demonstrations.

Figure font A dialog box offers the choice of font for the figures.

Background color A dialog box is displayed to change the back-
ground of figures, between subplots.

Ignore assert In Sysquake programs, the assert function can
help in reporting errors during development. If Ignore Assert is
on, the evaluation of assert is skipped, which can provide slightly
improved performance. Usually, you should switch it on during de-
velopment, and off when using SQ files whose you trust the quality.

Ignore private and hideimplementation attributes of
functions Functions stored in library files can be public, i.e.
accessible from other libraries and SQ files, or private, i.e.
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available only to other functions in the same library. Their
implementation can be hidden, so that error messages are the
same as for native functions and do not contain information about
the error location; and debugging cannot step into them. If Ignore
private and hideimplementation attributes is on, private functions
can be executed as if they were public and hideimplementation is
ignored. This can be useful for development, to debug functions
from the Command window.

Code Optimization Programming code of SQ files is converted
to an intermediate code for faster execution. Code optimization
further speeds up its execution by replacing some sequences of
code with faster alternatives. Most of the time, you should keep
this option set.

Rate Limit to Mouse Drag and Move Handlers Sysquake pro-
grams often perform repeated computation when the mouse is
moved. When Rate Limit is on, the rate of these computations
is limited to 25 times per second; otherwise, it is limited only by
the processing power of the computer. Limiting the rate can re-
duce the power consumption, with increased battery autonomy on
laptop computers and less fan noise on desktop computers.

SQ File Possible Error Warnings When you develop new SQ
files, Sysquake can help you to find potential problems. In addition
to errors which prevent the SQ file to run at all, which are always
reported, Sysquake can analyze your code and find programming
patterns which are often not intended and cause errors difficult to
find. You should leave this option off for SQ files which are known
to be correct, because warnings do not always correspond to errors
and do not mean that the SQ file has a lower quality.

Default Sandbox Mode for SQ Files SQ files can not only per-
form mathematical calculation, but also access files, network, or
other devices. This makes the execution of SQ files obtained from
trusted sources potentially dangerous. The sandbox is a secure
environment where all commands which could be harmful are dis-
abled. It can be accessed by code with the sandbox function, or
enforced globally for SQ files. The Default Sandbox Mode speci-
fies whether the sandbox mode is enabled when new SQ files are
opened.

Ask Before Closing If you have change the state of an SQ file
(typically by manipulating the graphics interactively) and Ask Be-
fore Closing is on, Sysquake will ask you if you want to save it to
an SQD file when you close the window.
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Settings

The Settings menu, available only for some SQ files, contains actions
defined in the current SQ file. These actions typically modify the sys-
tem in a noninteractive way, for example to enter numeric values for
the coefficients of a model or to change the structure of a controller.
SQ files can also redefine the menu name and define several menus.

When a dialog box is displayed, the edit field contains the current
values of one or several parameters, separated by commas. Values
can be real or complex, scalar, vector, matrices, lists, structures, or
inline or anonymous functions. Polynomials are represented by their
coefficients, in decreasing power, in a row vector. Here are some ex-
amples:

Type Example

Real scalar 1, 2.3, -3.2e5
Complex scalar 3i, 1.2-5.4j

Row vector [4,2,6]

Column vector [4;2;6]

Polynomial [1,2,5]

Matrix [1,3;2,8]

Set of polynomials [1,4.9,3.1;1,6.2,2.6]
Identity matrix eye(3)

Range 1:10

List {1,2:5,"'abc’}
Structure struct('A’,[1,2;3,-1]1,'B’,[3;5])

Anonymous function @(t,tau) 2xexp(-t/tau)

Plots

The Plots menu, available for most SQ files, contains the list of fig-
ures which can be displayed. General-purpose SQ files usually define
figures for everything you might want to observe, but only display a
few of them by default. More specialized SQ files can have one or two
plots which are displayed by default; in this case, the Plots menu is
less useful.

To change one of the figures, first select it (click the selection button
in the toolbar or choose Select in the Figure menu), then choose one
of the entries of the Plots menu. You can change the number of figures
which are displayed simultaneously with the Layout menu (see below).

Figure

The Figure menu (see Fig. [3.6) permits to select one of the five modes
of operation on the figures, as described above, and to change display
options for the selected subplot(s). A subplot is selected either if it has
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Figure 3.6 Figure menu

been clicked in Select mode, or if it is alone. Depending on the figure,
some options may be disabled.

Manipulate, Zoom, Zoom X, Drag, and Select Selects one of
the modes of operation.

Locked Scale SQ files typically define a default scale for each fig-
ure. The scale may adapt to the figure contents. When you zoom
or drag the figure, the scale is locked. You can unlock the scale of
the selected subplot and revert to the default scale by unselect-
ing Locked Scale; you can also lock an unlocked figure, e.qg. if you
want to better observe small amplitude changes when you manip-
ulate another figure. Note that the figure which is manipulated has
always its scale locked during the manipulation.

Log X, Log Y, and dB Y With Log X, the horizontal scale becomes
logarithmic, and negative values are discarded. With Log Y, the
vertical scale becomes logarithmic. dB Y is the same as Log Y as
far as the contents of the figure are concerned; however, the axis
is labeled in dB’s, i.e. a linear scale where a difference of 20 rep-
resents a factor 10 for the data: y’[dB] = 20 loglO(y) (decibels
are defined with 10 instead of 20 for powers; the definition used
by Sysquake is valid for voltages, currents, mechanical displace-
ments, etc. which are proportional to the square root of powers).
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Figure 3.7 Layout menu

Options The Options submenu has three items which may be en-
abled or disabled. Frame displays a rectangular frame around the
graphics with ticks and a white background. Margin leaves room
around the frame for the title and axis labels. Label displays the
title of the figure. Legend displays the meaning of symbols and col-
ors in figures, provided the feature is implemented in the SQ file.
Legends are located in one of the four corners of figures; they can
be moved with the mouse.

Grid The Grid submenu sets the level of detail of the grid which
is displayed in the back of the selected subplot(s). The availability
and the kind of grid depend on the figure.

Sandbox Mode Sandbox Mode specifies whether potentially
harmful commands (commands which give access to files,
network and devices) are disabled (see above).

Idle Processing Some SQ files perform computations even when
you do not interact with them, for example for animated simula-
tions. The computation may slow down the whole computer. To
suspend it, unselect Idle Processing. Note that the menu entry is
disabled if the SQ file does not implement idle processing.

Layout

The Layout menu (see Fig. [3.7)) permits to choose the number of sub-
plots to be displayed simultaneously.

1x1, 1x2, 2x1, 2x2, 2x3, 2x4, 3x2, 3x4, 3x4, 4x4 The corre-
sponding number of subplots is displayed. If some subplots were



Getting Started 33

selected, they are preserved in the new layout; otherwise, the sub-
plots remain at the same position.

Free Instead of being constrained on a regular grid, the subplots
can be freely moved and resized with the mouse (in Select mode).
When the window is resized, all subplots are scaled the same way.

Fixed Size The subplots can be freely moved and resized with the
mouse like with Free layout, but their size and position remain fixed
when the window is resized.

View (Windows)

On Windows, the View menu permits to show or hide toolbars and
panels.

Command Panel The command line interface is available in a sub-
panel of the main window. You can show it or hide it with the menu
entry View/Command Panel. When is it shown, you can resize it by
dragging the separation with the mouse.

Toolbar The toolbar can be hidden or shown. It can also been torn
off or docked with the mouse.

Status Bar The status bar (the region at the bottom of the main
window where status messages are displayed) can be shown or
hidden.

Help

The Help menu provides information about Sysquake with access to
the online version of its user manual and a simple integrated SQ file;
and about the SQ file in the front window. The entry "About Sysquake"
is located in the Sysquake menu on macQOS. Selecting it displays infor-
mation about the version of Sysquake and whom it is registered to.

Contextual menu

Some commands which are related to the currently selected figure(s)
are available from a contextual menu, obtained by clicking with the
right button of the mouse (on Macintosh with a single-button mouse,
hold down the Control key and click). The figure becomes selected,
and a contextual menu appears right under the mouse cursor with
commands for choosing the figure and changing the scale and the
grid. This is very convenient to avoid switching to and from the Select
mode.
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3.5 Command-Line Interface

The command-line interface is useful for two purposes:

- as a powerful calculator, where you can type expressions and get
answers;

- as an help for developing, testing and debugging new SQ files.

You can ignore it if you use existing SQ files. Note also that you cannot
add interactivity from the command line; interactivity requires SQ files
(or SQ scripts, which are very close to the commands you can type in
the command-line interface).

The command-line interface, SQ scripts, and SQ files are detailed
in other chapters.

3.6 Interruption Key

The goal of Sysquake is to be as interactive as possible. However,
nothing in its design prevents it from doing long computations, from
the command line as well as in SQ files. You can interrupt it by pressing
the following keys:

On Windows: Break (Control-Pause).

On macOS: Esc or Command-dot (hold down the Command (Ap-
ple) key, then type a dot).

On Linux: Shift-Esc.

When the computations take more than half a second in an SQ file, a
mark is displayed at the bottom left of the window.

3.7 Memory

LME uses a block of memory of fixed size. If a function call requires
more space than the current size of the block allows, e.g. magic(500)
for a 500x500 magic array, an error occurs. However, after the error,
an attempt is made to increase the available memory. If you typed the
command in the command-line interface (see below), you can retry
(use the Up arrow key to retrieve the previous command from the his-
tory buffer). But if the error occurred during the execution of a handler
(a function defined in an SQ file), Sysquake will retry automatically.
This procedure is usually transparent for the user, unless a dialog box
has been presented; in that case, it may be displayed several times
before either enough space is allocated or the maximum amount of
memory is reached.
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3.8 Extensions

Sysquake is an self-contained application which does not rely on other
files to run, except for the registration file SQ_Reg.key for versions
which require it.

With Sysquake Pro, it is possible to add optional functionality with
the help of extension files. For instance, additional high-quality nu-
meric functions are provided by the file "LMELapack".

At startup, Sysquake scans the folder "LMEExt" located in the same
folder as Sysquake Pro itself and loads all extensions it finds there.
Other files are ignored. Extensions may be removed without harm;
note however that some libraries and SQ files may require them to
run correctly.

3.9 Preference Files

Sysquake retains information about the user preferences between in-
vocations. The location where this information is stored depends on
the platform.

Windows

Preferences are stored in the system registry, in HKEY_CLASSES_ROOT
for information related to the association between Sysquake, its files
and icons (preference "Handle SQ Files" as described above) and in
HKEY_CURRENT_USER/Software/Calerga for other preferences.

macOS

Preferences are stored in the file "com.calerga.sysquake.plist" located
in the preference folder, ""/Library/Preferences". The file has the struc-
ture of standard preference files on macOS and can be edited with the
application Property List Editor which comes with the Apple developer
tools.

Linux
Preferences are stored in the home directory in the following files:

.sysquakeprefs Main preferences (text file with pairs
name="value")

.sysquakehistory Past commands, as they can be retrieved with
the up arrow key in the command window, as a text file. Entries
are separated with lines containing two exclamation marks.
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.sysquakestartupcmd Startup commands (text file)

Preferences of other applications of the Sysquake software suite
are stored in ‘".sqappbuilderprefs", ".sqruntimeprefs", and
".sysquakeleprefs".

3.10 Environment Variables

Environment variables are named strings which can be specified for
each running application. They are supported on many platforms, in-
cluding Windows, macOS and Linux. How they are used and which
name is meaningful depend on the application, its libraries and the
operating system.

In Sysquake, environment variable values are obtained with the
function getenv defined in the Shell extension. In addition, Sysquake
for Linux uses the following environment variables:

HOME Home directory, where preference files are found. This vari-
able is set automatically by Linux.

SYSQUAKEDIR Base directory of Sysquake, where the standard
directories "SQ files", "Lib" and "LMEExt" are located. If this
variable is not defined, Sysquake attempts to use its own name as
it is provided by the operating system (this works only if Sysquake
is launched by specifying a relative or absolute path, not if the
path is implicitly found in the PATH environment variable); or
as a last resort, the fixed directory "/usr/local/sysquake" or
"Jusr/local/sysquakepro".

SYSQUAKEKEY Path of the registration file, whose name
is usually "SQ Reg.key" or "SQ.key". If this variable is not
defined, the registration file is searched successively in
"SYSQUAKEDIR/SQ Reg.key", "HOME/.Sysquake/SQ_Reg.key",
"HOME/SQ_Reg.key", and "./SQ_Reg.key", where SYSQUAKEDIR
and HOME are the values of environment variables SYSQUAKEDIR
and HOME respectively, and "." is the current working directory.

X11BROWSER or BROWSER Path of the HTML application to use
to display the documentation. If neither of these variables is
defined, Sysquake tries to execute htmlview, firefox, mozilla,
netscape, opera, and finally konqueror. In versions of Sysquake
which support it, the launchurl command uses the same browser.
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SQ Files

This chapter describes the main SQ files provided with Sysquake. For
other SQ files with a more limited scope, please consult the on-line
documentation.

Automatic Control
PID_ct.sq Continuous-time PID controller.
PID_dt.sq Discrete-time PID controller

RST ct.sq Continuous-time  two-degrees-of-freedom linear
controller.

RST_dt.sq Discrete-time two-degrees-of-freedom linear controller.

LQR _ct.sq Continuous-time two-degrees-of-freedom
linear-quadratic regulator.

Signal Processing
filter.sq Design of analog and digital filters.
id_p.sq Parametric identification.

id_np.sq Non-parametric identification.

4.1 PID ct.sq

Continuous-time PID controller
PID controllers, or proportional-integral-derivative controllers, are
probably the most popular kind of linear single-input single-output
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controllers. This is justified by their simplicity and their effective-
ness for a large class of systems. Taking as input the difference be-
tween the desired set-point r(t) and the measured system output
y(t) ("error" e(t) = r(t) — y(t)), they have three terms with easy-to-
understand effects which are added up, and three parameters to ad-
just their weights:

- a proportional term (the larger the error, the larger the control
signal to reduce it);

- an integral term (if a nonzero control signal is required to can-
cel out the error, the control signal is increased until the error
vanishes);

- a derivative term (the evolution of the error is anticipated to in-
crease damping).

Weights can be specified either separately for the three terms, or as
a global gain kp and two time values T1 and Tp which do not depend
on the gain of the system. PID ct.sq uses the latter parameterization.
The control signal u(t) is

)=k t L tdt Tdet
u()—pe()+ﬁfoe() +DE())

The transfer function of the controller K(s) = U(s)/E(s), where U(s)
and E(s) are the Laplace transforms of y(t) and e(t), respectively, is

1
K(s) =kp (1 +—+ TDS)
TIS

Translating the conceptual simplicity of the PID into an effective
design is not always straightforward. PID_ct.sq displays the graphics
where common specifications can be checked (see Fig. [4.1I); you can
manipulate the PID parameters, the controller gain kp in the Bode,
Nyquist, or root locus diagram, or the time values of the integrator
and the derivator in the Bode, root locus, or open-loop poles diagram.

For set-point tracking, filtering the same way the measured out-
put and the set-point by considering only the error e(t) = y(t) — r(t)
does not give a good transient behavior when the set-point is discon-
tinuous. The set-point is usually not differentiated. In addition, the
proportional term of the controller kp applied to the set-point can be
reduced by a factor b smaller than 1. A third common improvement
is to filter the derivative term to limit the amplification of noise at
high frequencies (this is actually required to have a causal controller);
the filter is parameterized with a number N, typically between 10 and
20, which is the bandwidth of the effect of the derivator term. In the
Laplace domain, the control signal is
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Figure 4.1 PID ct.sq

1 DS
U(s) =kp (bR(S) —-Y(s)+ E E(s)— m Y(S))

Figures

The figures are the same as those defined for RST_ct.sq, except for
the Open-Loop Zeros and Poles and the Closed-Loop Poles which are
not defined.

Settings

The System, Sampling Period, method for converting to digital con-
troller, and Damping Specification have the same effect as the cor-
responding menu entries defined in RST _ct.sq. Two new entries are
defined.

PID Coefficients

The three parameters of the PID ( kp, Tt and Tp) can be edited in
a dialog box. For P, PI, or PD controllers, set the parameter of the
missing component to the empty matrix [].
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No Derivator On Reference

When the input of the PID controller is the error between the set-point
and the measured output, discontinuities of the set-point are differen-
tiated by the derivator component of the PID and yield infinite values
for the control signal (see above).

When No Derivator On Reference is checked, the set-point is not
differentiated.

Display Frequency Line

When selected, moving the mouse above a frequency response (Bode
or sensitivity) will display a corresponding line in other frequency re-
sponses, Nyquist diagrams, and zero/pole diagrams.

4.2 PID _dt.sq

Discrete-time PID controller

The PID controller is fundamentally a continuous-time controller.
However, it is often implemented with digital electronic devices (such
as microcomputers, microcontrollers, or FPGA). Sampling effects may
change performance in subtle ways, especially when the sampling fre-
quency is not very high with respect to the bandwidth of the controlled
system. Instead of converting a continuous-time PID controller, it is
possible to design a PID directly in the discrete-time domain, approx-
imating the integration and derivation by sums and differences, re-
spectively. The parameters of the PID keep their standard meaning.
PID_dt.sq does for discrete-time PID controllers what PID ct.sq does
for continuous-time PID controllers (see Fig. [4.2). In its simplest form,
the transfer function K(z) of the PID is

Ts z—1
K(z2) =kp (1+ +Tp )
Ti(z—1) Tsz

where T is the sampling period.

Like the continuous-time PID controller, the discrete-time controller
is usually not implemented like this: the derivative term is not applied
to the set-point, the proportional gain is reduced for the set-point,
and the derivative action is filtered. The transfer function used for
feedback is

Ts NTp z—1 )

K(z) =kp (1 + + .
Ti(z—1) Tp+NTs z—Tp/(Tp + NTs)
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Figure 4.2 PID_dt.sq

Figures

The figures are the same as those defined for RST_dt.sq, except for
the Open-Loop Zeros and Poles and the Closed-Loop Poles which are
not defined.

Settings

The System (continuous-time model), System (discrete-time model),
Sampling Period, and Damping Specification have the same effect as
the corresponding menu entries defined in RST_dt.sq. Two new entries
are defined.

PID Coefficients

The three parameters of the PID ( kp, T1 and Tp) can be edited in
a dialog box. For P, PIl, or PD controllers, set the parameter of the
missing component to the empty matrix [].

No Derivator On Reference

When the input of the PID controller is the error between the set-point
and the measured output, discontinuities of the set-point are differen-
tiated by the derivator component of the PID and yield infinite values
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(or very large values in the case of a discrete-time PID controller) for
the control signal. To avoid that, the set-point is usually not differenti-
ated. The control signal is

Ts & T
u(k) = kp (6(/<) + 726(!’)— - (y(k)—y(k— 1)))
Ii=0 T

S

Display Frequency Line
When selected, moving the mouse above a frequency response (Bode

or sensitivity) will display a corresponding line in other frequency re-
sponses, Nyquist diagrams, and zero/pole diagrams.

4.3 RST ct.sq

Continuous-time two-degrees-of-freedom linear controller
RST controllers, or two-degrees-of-freedom linear single-input
single-output controllers, are a more general form of linear controller
than the popular PID controller. Their name comes from the three
polynomials which characterize them. In addition to the feedback
S/R, which permits to reduce the sensitivity to model uncertainties
and to disturbances, the reference signal is filtered by T/R, which
permits better tracking. The two degrees of freedom refer to the
independence between those two 